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What’s New? 
MicroGDS has been repackaged and rebranded as MicroGDS 11.  A number of new features and 

enhancements since version 10.0 have been made, a summary of which is provided here: 

 new 64-bit version of MicroGDS 

 new facilities for creating and drawing intelligent objects 

 new per-window axes, and save and restore axes commands 

 new batch facilities for export, print, and publish 

 much improved error and warning reporting 

 new settings files for storing preferences and settings 

 new facility to save window layouts to profiles 

 new materials for rendering 

 rendering enhancements 

 enhanced photo features 

 new Photo Phase Editor to change overrides of a window photo 

 new facility to save units in styles 

 new command to explore Document Organizer folders 

 new Revision Clouds command 

 new AutoCAD import and export features, including AutoCAD 2010 support 

 extended API functions 

 new batch of Rendering Textures (for MicroGDS 11 Pro) 
 

In addition, MicroGDS 11 provides many other enhancements and fixes. These are covered in a later 

section, by menu command in menu bar order. 
 

For full details on all MicroGDS features, refer to MicroGDS Help. 

Key new features 

New MicroGDS products 
The four flavours of MicroGDS have been repackaged as two new products: MicroGDS Standard and 

MicroGDS Pro. 
 

Both products continue to share a comprehensive set of features, but now the ability to work in multi-user 

mode is available with both MicroGDS Standard and Pro. This means that a number of users can access the 

same data in multi-user projects simultaneously. 
 

MicroGDS Pro also provides the full 3D solid and surface modelling, plus the sophisticated, 

photo-realistic renderer; MicroGDS Standard has a reduced set of 3D functions and rendering capabilities. 

New 64-bit version of MicroGDS 
 

There is now a 64-bit version of MicroGDS that you can install onto a machine running a 64-bit version of 

Windows XP, Windows Vista, or Windows 7. This enables you to take advantage of the improved memory 

handling of a 64-bit machine. The main difference is that the 64-bit version of MicroGDS lets you access 

more memory on a 64-bit machine, which in turn, will help you work more easily with large MicroGDS 

projects. 
 

You can run the 32-bit version on a 64-bit machine, but not the other way around. If you have a 64-bit 

machine, you might want to consider installing the 32-bit version of MicroGDS if you have existing 

MicroGDS CPD databases that you want to continue to use. These databases are created with Jet 4.0 and 

Microsoft do not supply a 64-bit version of the Jet driver. 
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BIM Intelligent objects 

The ability to create intelligent, parametric objects is available with MicroGDS 11. In MicroGDS, an 

intelligent object is constructed from graphics and attribute data, or just attribute data. An intelligent object 

has a name, hook point, scale, and rotation associated with it, in the same way as for other types of objects. 

When you have created an intelligent object, it is drawn in the selected drawing style according to the attribute 

data values. 
 

MicroGDS supplies a number of drawing styles for drawing intelligent objects. For example, the Perspective 

drawing style shows a general purpose 3D view of the solid model whereas the Elevation drawing style shows 

a horizontal, orthographic view of the solid model. 
 

You can create intelligent objects using predefined BIM objects simply by following a set of naming 

conventions. This enables you to create walls, doors, windows, and slabs. To use the intelligent objects 

supplied with MicroGDS, add the following entry to the document‘s style search path: 
 

<*MICROGDS_COMMON_APPDATA>bim 
 

The files in this location make the BIM intelligent objects and drawings available, together with the related 

styles which include linestyles, mnemonics, and schemas. 
 

Note that if you define your own intelligent objects, you need to reference the relevant path to your own files 

on the style search path. 
 

For example, the basic workflow to create a predefined intelligent wall object is: 
 

1   Set the style search path to the ‗bim‘ folder location. 
 

2   Set the drawing style to, say, Perspective. 
 

3   Create a new object using the required object name IfcWallStandardCase. 
 

4   Set the objectstyle to, say, Brick-Cavity-Block. 

Note that the objectstyle is also new in MicroGDS 11. An objectstyle is an object schema that contains a 

set of attributes which describe the type of an intelligent object. For example, it can describe a wall as a 

simple Block or a Brick-Cavity-Block construction. It also forms the association between an object and its 

intelligence. 

You set the objectstyle of an intelligent object in the Properties window. 
 

5   Draw the graphics to represent the centreline of the wall. 

For example, drawing a 6000mm x 9000mm rectangle to represent an outside wall is now drawn 

intelligently as: 
 

 
 

You can customize the attributes of the wall, such as the thickness and material of each layer, as required. 

After adding predefined internal walls, doors, windows, and a floor slab, the building could progress to: 
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If you wish, you can customize the BIM environment, for example, to define your own naming standards. 
 

In addition, if you want to create intelligent objects of your own such as a different style door or a roof, you 

can define new BIM components. 
 

Note that the object name assistant has been extended to allow an objectstyle to be associated with an object at 

the time it is created. 
 

Furthermore, to work better, for example with BIM and the IFC, the display of attribute data in the Properties 

window has changed: 

        if the Mnemonic style defines a Prompt, the prompt text is displayed as the name of the attribute 

        if the Mnemonic style does not define a Prompt, then the mnemonic name is displayed (as in earlier 

versions 

 

Save and restore window axes 
Each window definition in a document now has its own set of axes. When you open a view in a window 

definition, its axes are loaded from the window‘s stored values. When you move, rotate, or change the axes‘ 

scale, you can now explicitly save the axes for the window and restore them again later. MicroGDS saves the 

axes origin, rotation and scale, the units and decimal places, and the X and Y grid spacing (if you are using a 

grid). 
 

Note that the window at the start of a command is always the window where  object creation takes place (apart 

from Construct Photo). If you change windows during a series of snaps, graphics are never created in the last 

snapped window. This behaviour is different to earlier versions of MicroGDS where  some commands created 

graphics in the last window snapped. 

 

► To save a windows axes 

 on the View menu, click Save Window Axes 

► To restore a window’s saved axes 

  on the View menu, click Restore Window Axes 
 

If you are using a grid, the grid location and orientation changes to match the recalled axes. 
 

 
 

 

Exporting and publishing views 
In MicroGDS 11, the Window Export command has been divided into two commands: Window Export and 

Window Publish. The model-based formats remain with the Export commands and the image-based formats 

have moved to the new Publish commands. 
 

Notes: 

 you can export and publish to DWG format 

The difference is that MicroGDS translates the structure for export and draws the content for publish. 

 PLO and VRML are no longer supported and have been removed from the Export formats 
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Working with batch views 

MicroGDS 11 introduces new batch commands to enable you to export, publish, and print multiple views. 

These commands also provide options to save and load a set of views, and save and load the current settings, 

enabling you to easily export, publish, or print the same sets of views repeatedly. 
 

Note that batch export is for DXF and DWG formats only. 
 

► To batch export, publish, or print a set of views 

1   Select the views from the Window Definitions tab on the Document Organizer. 
 

2   Right-click over a selected view and click the Batch command you require from the shortcut menu. 

The appropriate Batch dialog box is displayed, for example: 
 

 

The selected views are listed on the left of the dialog box. 

You can add to, remove, and reorder the views as required: 

 to add a view, drag the view from the Document Organizer 

The views can be in the same document or in different documents.  

You can also add views by loading a saved list of views, described next. 

 to remove a view, select the view and click    
 

 to change the order of a view, select the view and click   or   

You might do this if you are printing several views to a single file but want to arrange the output in a 

particular sequence. 



What’s new in MicroGDS 11 5  

 
 
 
 

You can also save the list of views to a file and load a saved list of views: 

 to save the current list to a text file, click ‗Save list‘, browse to the location in which to save the file, 

type a name for the file and click Save 

 to load a saved list of views, click ‗Load list‘, locate the text file and click Open 

If any view cannot be found, for example because it has been renamed, it is omitted. 

You can load more than one set of views if required. 

3   Select the batch options you want on the right side of the dialog box. 
 

Many options are the same as those for the equivalent command for a single view. Other options are 

provided to let you control how the multiple copies will be handled. For more details, refer to MicroGDS 

Help. 
 

You can save the settings to an xml file and load a set of saved settings: 

 to save the settings to an xml file, click ‗Save settings‘, browse to the location in which to save the file, 

type a name for the file and click Save 

 to load a file of saved settings, click ‗Load settings‘. locate the xml file and click Open 

This makes it easy to use the same set of options and values with the same set or with a new set of views. 
 

Improved handling of warning messages 

There are a number of warning and error conditions detected by MicroGDS, typically when opening a 

document, for which detailed information is now available. For example, missing source files for photos or 

instance objects, or fonts that are used in a drawing but are not installed on the current machine. In these 

cases, the action taken by MicroGDS in previous releases has been replaced by reporting the information in a 

Problems dialog box. 
 

For example: 
 

 
 

By default, if any warnings or errors of this type are detected when you open a document, the Problems dialog 

box opens after the document has loaded. You can tell MicroGDS to not automatically open the dialog box by 

selecting the ‗Don‘t show this dialog until I ask for it‘ check box. 
 

Whenever there are unsolved problems in a document, a yellow warning triangle  is shown on the 

information bar. You can open and close the Problems dialog box by double-clicking this button. 

► To view and resolve a problem reported in the dialog box 

1   From the ‗In document‘ list, select the document whose problems you want to resolve. 
 

2   In the ‗Problems box‘, double-click the message whose problem you want to resolve. 

An associated dialog box is displayed giving precise details about the problem. 
 

3   Select the message details and correct the error as appropriate. 
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Preferences and settings 
In past versions, MicroGDS wrote preferences and settings to the Windows registry. This made it particularly 

difficult to transfer settings between users and machines. Now, MicroGDS writes most of its details to various 

xml files, making it much easier to copy and share settings. Furthermore, settings can now be saved at 

different levels, including user-level, MicroGDS document level, and CAD manager level. This is done using 

the new Preference Files Editor. 
 

Many companies will have office standards for different types of MicroGDS items, such as layer names, 

colours, linestyles, and so on, and have set up your working environment to suit. Sometimes however, you 

might have a project that needs its own standards, such as where a client always follows a particular layer 

naming strategy. The Preference Files Editor lets you set general and project settings, allowing you to choose 

to override a setting on an individual basis. If you want to use a project-specific settings file with a different 

project, just copy the settings file to the location of that project. 
 

► To display the references Files Editor 

 on the File menu, click Preference Files 
 

 
 

Restrictions may be set at any level to enforce its usage. This is called a policy. For example, it might be your 

company policy to always display the unit of measurement in dimensions.  Where a policy is in place, any 

subsequent change made to the setting‘s value at any other level is ignored. 

 

User profiles 
MicroGDS 11 introduces profiles to store and recall different window layouts. A profile includes toolbars, 

menus and shortcuts, view controls, dialog box locations, window sizes, column widths, and so on. By default, 

these settings are saved to the profile called ‗current‘. You can create additional profiles and load them as 

required. A typical use would be if you often switch between 2D drawing and 3D design and would like a 

different screen environment for each. 
 

A new Profile submenu has been added to the Window menu enabling you to select, save, delete, and 

customize profiles. 
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When you select the Customize Profile command, MicroGDS displays the Customize dialog box. This 

replaces the previous Toolbars dialog box of earlier versions. 
 

The Customize dialog box presents a number of tabs which enable you to customize the view controls and 

shortcuts along with the toolbars, flyouts, and status bars. A big addition here is a new Menu tab which you 

can use to customize your menus: 
 

 
 

You can now rename, move, copy, and delete menus and commands using the Menus tab. This replaces the 

previous method of customizing menus by editing the automenu configuration file. 

 

New and enhanced material shaders (MicroGDS Pro only) 
There are a number of new material shaders in MicroGDS Pro and also several enhancements to existing 

materials. 
 

Note that full descriptions and sample images are available in the MicroGDS Help. 

New Material Colour shaders 

The following new colour shaders are available: 

 Fleck: use the Fleck solid shader to colour an object with a base colour which contains flecks in a chosen 

colour. This can be used, for example, to model a range of non-uniform colour plastics. 
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 Wrapped Colour Blend: use the Wrapped Colour Blend shader to blend two wrapped images, two colours, 

or an image with a colour. 
 

 

Note that if you blend using image files, these take precedence over any specified colours. When using 

image files, best results will be achieved if the images are the same size. 

New materoal Reflectance shaders 
 

The following new reflectance shaders are available: 

 Blurred Conductor: Use the Blurred Conductor shader to create a metallic material that supports 

reflection, and also blurring of reflected images. 
 

 

 Blurred Dielectric: Use the Blurred Dielectric shader to create a glass-like material that supports reflection 

and refraction, and also blurring of reflected images. 
 

 

 Blurred Glass: Use the Blurred Glass shader to create a material that resembles frosted glass that supports 

reflection, refraction, and blurring effects. 
 

 

 Blurred Mirror: Use the Blurred Mirror shader to create mirror reflecting materials that supports reflection 

and blurring effects. 
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 Glossy Dielectric: Use the Glossy Dielectric shader to create a glass-like dielectric surface that has both 

reflective and transmissive properties. 
 

 

 Glossy Glass: Use the Glossy Glass reflectance shader to create a glass-like material surface that has 

reflective, refraction, and blurring properties. 
 

 

 Glossy Metal: Use the Glossy Metal shader to create a metallic material that supports reflection and also 

blurring of reflected images. 
 

 

 Glossy Mirror: Use the Glossy Mirror shader to create a mirror-like material that has reflective properties. 
 

 

 Wrapped Specular Map: Use the Wrapped Specular Map shader to create mirror reflecting materials using 

ray tracing which supports reflection with the specular and mirror factors, determined by image maps. 
 

 



What’s new in MicroGDS 11 10  

 
 
 
 

New material Transparency shader 

 

Use the new X Ray shader to create X ray-like transparency effects. 
 

 
 

Additional material enhancements 

 The ‗Lit Appearance‘ reflectance shader has new ‗Transmission Factor‘ and Refraction attributes. The 

shader now supports an accurate simulation of dielectric (glass-like) materials that have both reflective 

and transmissive properties, at the same time as simulating light emission. 

 A problem with the Wrapped Roof Shingles Displacement shader where the Double Castellated pattern 

and the Rectangular pattern looked the same has been fixed. 

 The Metal reflectance shader has a new ‗Diffuse Factor‘ attribute that makes it pick up diffuse, indirectly 

reflected light bouncing off other surfaces, and render correctly in scenes using Global Illumination. The 

effect is similar to the Plastic reflectance shader, but uses the surface colour for specular highlights and not 

a fixed shader-specified colour. 

Note that this may make materials that use the Metal shader appear slightly different in scenes that do not 

use Global Illumination. If this is important, set the Diffuse Factor to 0.0. 

 The ‗Wrapped Alpha‘ and ‗Wrapped Mask‘ transparency shaders have a new ‗Invert Mask‘ attribute to 

reverse the mask transparency. 

 The Auto Plane Texture Space shader has a new Texture Orientation Control attribute. This lets you 

control the orientation of the texture in each of the six axes directions, and whether the texture is mirrored. 

 Shadow map calculations are now faster and use less memory. Specifically, materials no longer load their 

wrapped image files (as they are not needed for shadow map calculations). The improvements are 

particularly noticeable for scenes with large textured images, and may also avoid some out-of-memory 

errors. 
 

Enhancements to previewing materials 
 

To provide better display of previewed materials, a number of changes have been made to the Material dialog 

box: 

 The default view direction has been moved slightly, away from the corner-diagonal of cube primitives. 

This means that you can now see how glass type materials bend light according to their ‗refractive index‘. 

 The graduated blue-black Horizon background has been replaced by an ‗Image Cube‘ environment map 

together with a ‗Link to Environment‘ background, which will reflect correctly in reflective shaders (both 

Mirror type and Environment reflectance). 
 

 

Note that if the standard image-cube files cannot be found, the preview falls back to a Horizon 

background. 



What’s new in MicroGDS 11 11  

 
 
 
 

 A new ‘Cube & Polygon‘ option has been added to the Preview list of primitives. 
 

 

 The preview in the Material dialog box is rendered using Good Image quality. 

 In MicroGDS version 10, transparent shaders were previewed in a special way if the ‗shape & Polygon‘ 

option was used, applying the previewed transparent material only to the shape. The polygon remained in 

DEFAULT material so that it could be seen through the shape. In MicroGDS 11, this is extended to 

provide a special preview of the ‗Shadow Catcher‘ reflectance shader. 

If you preview ‗Shadow Catcher‘ with any of the ‗shape & Polygon‘ options, the shape is left in 

DEFAULT, so as to cast a shadow on the polygon (which is seen over the new background). 

 

Enhancements to light shaders (MicroGDS Pro only) 
The following enhancements have been made to lights in MicroGDS Pro: 

 A new Sun + Sky light shader has been added. This creates a twin light source that is automatically 

calculated according to time and place. 

This shader addresses the need to have linked settings for separate Sun and Sky shaders, by combining 

them into one. If you wish to keep manual control of brightness or orientation, you can continue to use the 

existing separate shaders. 

Note that Sun + Sky also appears on the Sun tab of the render Environment dialog box and is used by the 

predefined lighting environments. 

 Ambient light shaders now offer the same colour and intensity attributes as real world lights. They now 

provide Intensity Units and Colour Temperature attributes. 

  The Sky light shader now has a more intelligent way of handling the Intensity attribute. Intensity now 

defaults to Automatic which means that the Intensity and Colour values for the light  are ignored and are 

calculated instead from the Sun Altitude and Sun Azimuth values. 

 You now specify whether to measure the Light Range distance by the light object‘s object scale or by the 

set axes scale, (in the units and scale shown on the Lightstyle dialog box), using the Use Object Scale 

attribute. 
 

New and enhanced environment shaders (MicroGDS Pro only) 
 

The following enhancements have been made to the renderer environment shaders in MicroGDS 

Pro: 

 A new Sun + Sky shader has been added to the Sun shaders. The shader attributes are exactly the same as 

the Sun + Sky light shader attributes. 

 To improve the lighting environments in MicroGDS, the predefined, weather-based styles on the render 

Environment dialog box have been reworked. The styles are now categorised as Day, Night, and Twilight 

lighting. Day and Twilight environments use the new combined Sun + Sky light shader making it very 

easy to adjust the lighting. Note that the previous day and twilight environments are still offered as a 

Weather group, with the sun now placed in a more realistic location. 

 The Scaled Image foreground environment shader has a new ‗Use Alpha Channel‘ attribute to use alpha-

channel data in image files. 

  A new Ambient shader has been added to the Sky shaders. The shader attributes are exactly the same as 

the Ambient light attributes. 
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 A new Auto-detect environment map shader can be used to create an environment from a single image 

file. 

The image file can be one of a number of different preset formats. 

 The Fixed Distance Cube environment map shader has been merged with the Image Cube shader. A new 

Kind attribute enables you to choose to have a fixed or infinite environment. 

Note that when a file from an earlier version of MicroGDS is opened, an ‗Image Cube‘ or ‗Fixed Distance 

Cube‘ environment is upgraded to the new form. 

 

Renderer enhancements (MicroGDS Pro only) 
 

When rendering to the render window, MicroGDS now uses progressive rendering. This initially shows a 

limited image, and then refines that image. The image is sampled at a few pixels, which are drawn 

repeatedly so that you see a coarse, blocky image. This image is then filled in with smaller pixels until 

finally rendered at 1 to 1 and in full quality. 
 

The following new options are available from the Render Options dialog box: 

 Final Gather options: 

— Whenever ambient lights are used with final gather rendering, MicroGDS now automatically switches 

to using ambient occlusion lighting. This is an intelligent method of shading which helps add realism 

by approximating how light radiates in real life. 

So, instead of the ambient light being uniform and constant, which can tend to flatten the scene, the 

light will vary around objects and in corners—spreading light across the whole scene. 

Use the ambient occlusion options to control the shader-like effects. 

— Select the ‗Handle translucency‘ check box to consider the amount of light transmitted through 

surfaces with the translucency reflectance shader, when any of the visibility rays encounter some 

geometry. This means that translucent surfaces can pass light through from behind, and that light will 

be gathered. 

Note that the auto-exposure action has been improved when rendering with Final Gather. This means that, 

although scenes now render correctly, some may render slightly differently to earlier versions of 

MicroGDS. 
 

For perspective views, a significant performance problem in the MicroGDS version 10.0 Renderer which was 

triggered by using a view-plane zoom has been addressed. Previously, in order to buffer the image for 

brightness adjustment, the buffer ignored the view-plane zoom, and the exposure adjustments forced the 

Renderer to render the full width of the view-plane. 
 

To resolve this, a major change has been made to the way MicroGDS communicates a view-plane zoom to the 

renderer. This affects certain Background and Foreground environment shaders (those which are image-based 

rather than model-based. Previously, MicroGDS rendered by zooming to a sub region of a large (off-screen) 

image-plane; now MicroGDS zooms in accurately on the requested area and renders only that area. 
 

This change affects the following shaders: 

 ‗Scaled Image‘ Foreground and Background shaders: the image is now stretched to fill the actual rendered 

area and not the whole perspective frustum. This means that you will no longer see a grainy zoom with 

large pixels. 

 Graduated and ‗Graduated Three Colour‘ Background shader: the colour fill is now graduated across the 

actual rendered area and not the whole perspective frustum. This means that a zoomed in view no longer 

zooms in on a small portion of the graduation, thereby showing no effective grading. 

 Clouds Background shader: the plasma-cloud effect now always fills the rendered area. This means that 

zooming no longer enlarges the effect to show individual fibrils. 

 Grid Background shader: may now show a small change in location and clipping of the grid. 
 

Note that the Send to Back command on the Window menu now also applies to the Render window. 

Previously, this command was not available when the active window was the Render window. 
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General Changes 
 

This section highlights a number of general changes in MicroGDS 11. 

 

User interface enhancements 
The following changes have been made to the general appearance of the MicroGDS window: 

 Many toolbar buttons have been redrawn and are now much easier to distinguish, especially when you are 

using small buttons. 

 When a no-entry cursor is shown in a document window, a brief explanation is now shown in a hover tip 

(if hover tips are enabled). 
 

 
 

  Drag graphics are now drawn using thin lines with translucent background edges. This improves the 

appearance of construction graphics. In earlier versions of MicroGDS, the drag graphics were drawn by 

reversing the colours of the window under the line. 
 

Photo enhancements 
In MicroGDS 11, after snapping the source window for a photo, MicroGDS now automatically displays the 

Photo Transform dialog box. This dialog box has been improved to provide more intuitive options: 

 

 
 

You can choose to not show the dialog box unless explicitly called by pressing ENTER during the Construct 

Photo command, by clearing the new ‗Show Dialog‘ check box. 
 

Use the Photo Transform dialog box to scale and rotate the photo. The scale options let you choose whether to 

set the photo size by specifying the scale view or by using snaps (maintaining the aspect ratio). 
 

Note that the Mirror option has been removed from the dialog box. To mirror a photo, use the Alter, 

Transform, Mirror command. 
 

The Photo Transform View dialog box has also been enhanced. It now shows the source scale or view size, 

depending on the view type, of the source window. Again, the Mirror option has been removed from the 

dialog box. 
 

In addition, the ‗Photo enlargement‘ property on the Properties dialog box has been renamed ‗Photo scale‘. 
 

Setting overrides for a window photo 
You can now set phase overrides for a window photo primitive. This enables you to specify different 

properties to that of the photo source. For example, you can override the assigned colour or linestyle of the 

graphics in the photo primitive. 
 

Overrides are set using the new Photo Phase Editor. You display the editor by double-clicking the ‗Photo 

phase overrides‘ box for the photo on the Properties window. 
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For example: 
 

 
 

Details about the phase that references the layer on which the photo resides are shown. Many settings are the 

same as those on the associated Window Editor. 
 

Note that: 

 the styles available from the Overrides lists are those that are available to the source document 

 the colours available from the Colour list are those stored in both the source document and the current 

document 

 The ‗Use primitive colours‘ check box lets you choose to override the phase colour and use any colours 

set explicitly to the primitives. This option has also been added to the Window Editor 
 

Other options that can be set for the phase of the photo include: 

 Reset: resets all phase properties to those set for the phase of the source window 

 Frozen: freezes the photo properties 

When selected, any changes made to the properties of the phase of the source window are ignored. 

 Upgrade now: saves the document of the source photo as a MicroGDS version 11 document 

MicroGDS adds a unique identifier to the phase on which the photo source resides. This means that if the 

associated layer is renamed or moved, for example, MicroGDS can continue to read, and reset if required, 

the original phase properties. 

When a phase needs to be upgraded to use overrides, a message is shown next to the ‗Upgrade now‘ 

button. 

Exploring folders 

A new ‗Explore folder‘ option has been added to the shortcut menu on the Document Organizer, for folders. 

This gives the ability, for example, to browse from an aliased folder on the Raster Files tab. 
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Names in paths 
MicroGDS now includes names that can be used in style search paths and aliases. Currently available are: 

 

<*MICROGDS_PROGRAM_FILES_COMMON> 

and 

<*MICROGDS_COMMON_APPDATA> 

In MicroGDS11, we currently use: 

<*MICROGDS_COMMON_APPDATA>Bim 

<*MICROGDS_COMMON_APPDATA>OSMastermap 

 

Units in styles 
To control how the distance values are shown and also how they are interpreted in the Charstyle, Linestyle, 

Lightstyle, and Material (for MicroGDS Pro) dialog boxes, a new Units drop-down list has been added. For 

example: 
 

 
 
 
 
 
 
 
 
 
 

This is because styles are created outside the context of any one window definition, and so do not use window 

axes or units. 
 

Note that the Lightstyle dialog box also has a Scale drop-down list. This is applicable only to the Range 

attribute in some light types available with MicroGDS Pro, and only when the Use Object Scale attribute 

is switched off. 

 

Snapping to a linestyle stroke 
A new ‗Use for snapping‘ option has been added to the Linestyle dialog box. This specifies whether to enable 

snaps for this stroke. When selected, you can snap to the line by pointing at the stroke‘s line, rather than only 

along the basic geometry of a line. 
 

For example, in the drawing below the geometry of the line is along the bottom stroke: 
 

 
 
 

top stroke: ―Use for snapping‖ off top stroke: ―Use for snapping‖ on 
 

Fill and vertex strokes use the offset and pattern strokes use both edges of the pattern. Note that the setting of 

this option is ignored for Output Co-ord space styles, which are never snapped to. 
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Disabling MicroGDS commands 
A new Commands tab has been added to the Preferences dialog box which enables you to disable (or enable) 

any MicroGDS command. 
 

 

 
 

You can enable or disable commands on the main menu, the Document Organizer, and the Information bar. 

Note that the Command list shows all MicroGDS commands available throughout MicroGDS Standard and 

MicroGDS Pro. This means that some MicroGDS commands might not appear on your menus depending 

on the product you are using. For example, if you are using MicroGDS Standard, you will see some 

advanced 3D related commands that are not available on your menus. 
 

You can set one of the following options for a MicroGDS command: 

 Default:  this will use the default state 

Unless the selected menu command is disabled at policy level, the default state for a menu command is 

‗Enabled‘. 

 Enabled: this forces the command to be available 

 Disabled: this forces the command to be unavailable 
 

Where a command has been disabled, MicroGDS shows  next to the command name. 

Disabled commands still appear in their appropriate menus but will not be available for selection. 

Note that a policy setting can be set for any individual command through the Preference Files Editor. 

 

Switching to Version 9 navigation 
Due to some user requests, we have provided a method of restoring the MicroGDS Version 9 behaviour for 3D 

navigation. 
 

In brief, the Version 9 behaviour moves or resizes the view-plane extent, zooming with a fixed perspective 

projection. In MicroGDS Version 10 (and later), the behaviour is to slide or advance the line of sight, 

changing the perspective projection while keeping a fixed perspective angle. 
 

You can restore the Version 9 behaviour using the ‗Use V9 mouse navigation for 3D‘ setting on the new 

Preference Files Editor. 
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Specifying the language of the MicroGDS user interface 
 

If you have Microsoft Windows Vista or later installed on your machine and you are starting MicroGDS from 

a command line, you can now add a command line qualifier to set the language for the MicroGDS user 

interface. 
 

For example, to specify MicroGDS Standard as the program to run and set the user interface language to 

French, type: 
 

“D:\Program Files\Informatix\MicroGDS\microgds.exe“ /option “Standard“ /language FR 
 

Note that this is useful only for specifying a language for which MicroGDS includes a translation. For 

example, if a French or German version is available, you would specify FR or DE respectively. 
 

If you do not specify a language, your current Microsoft Windows default user interface language will be 

used, if MicroGDS has a translation for it. 
 
 

Changes by menu command 
In MicroGDS 11, you will notice a number of changes to the menus and commands. 

The File menu 
The following additions and amendments have been made to the commands on the File menu. 

Restructured menu 

The File menu has been restructured and new entries have been added to support new features. 

 The style creation and modification commands and the Compile CV6 Font commands have been moved to 

a new Styles menu. 

 Style Mapping and Entity Mapping table commands have been removed from the File menu. These are 

now available directly from the appropriate Export and Import dialog boxes. 

 Export has been promoted from the File, Window submenu to the main File menu. 

Opening style files 

When a STY file is opened in MicroGDS 11, its style search path is set to the folder containing the STY 

file. The change is to help when defining styles that refer to other styles. For example, the box style of a 

charstyle or the mnemonics listed in a schema. 

New and amended preferences 

 General tab: The undo buffer size can now be customized. To support this, an ‗Undo buffer‘ box has been 

added. 
 

 
 

 File Locations tab: A number of entries have moved from the File Locations tab. For example, the default 

location of DXF linetype and chartype files are now specified on the appropriate export dialog boxes. 

  File Conversion tab: These settings have moved to the appropriate Import, Export, and Batch dialog boxes 

and the File Conversion tab has been removed. 

 ‗Shortcuts‘ and ‗View Controls‘ tabs: These tabs have been moved to the Toolbars dialog box, which in 

turn has been renamed Customize. The Customize tab is displayed by clicking Profile, Define on the 

Window menu. 
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 Commands tab: This is a new tab which provides the facility to specify which MicroGDS commands 

should be enabled. 

 Save preferences check box: Changes to the personal preferences are now saved in memory when you 

click OK on the Preferences dialog box. Therefore, this check box has been removed. 

Now when you exit MicroGDS, you are prompted to save settings only if there are unsaved personal 

settings. 
 

Printing 

The Information tab on the Print dialog box has been replaced by a new Information button. 
 
 
 
 
 

The Query menu 
You can now cancel the first position for the Query Angle and Query Distance commands using 

BACKSPACE. 

The Set menu 
The following additions and amendments have been made to the commands on the Set menu. 

 The Set Facet value is now saved between MicroGDS sessions. 

 Pressing the snap cycle key (default is SPACEBAR) now cycles through Grid and Dot choices (provided 

these are possible) as well as any other snaps that can be located within the snap radius. Earlier versions of 

MicroGDS allowed only one cycle of Grid and Dot and no other snap was offered. 

The Construct menu 
The following additions and amendments have been made to the commands on the Construct menu. 

Constructing revision clouds 

A new Revision Clouds entry has been added to the Curve submenu. You can use this to mark places on 

drawings that have been revised. 
 
 
 
 
 
 
 
 
 
 
 
 

When you draw the first arc, you specify the start point and the end point. The end point is then the start point 

for the adjoining arc. 

Revision cloud 
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Constructing text 

A new control has been added to the formatting options on the New/Edit Text dialog box. This gives access to 

options that enable you to change the case of selected text: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Solid menu 
The following enhancements have been made to the commands on the Solid menu. 

 The maximum value for the Smooth Angle command has increased from 90d to 120d. 

 The Move Face and Extrude Face commands accept BACKSPACE to remove the last selected position, 

but this was not documented. 

 The Rule Surface command now joins the ends of the surface correctly if the two loops ruled between are 

closed. It also smooths the line of join edges. 

 The Mesh Clump and Mesh Surface commands have been enhanced to work better with clumps that are 

already partly triangulated: if any face is not yet a triangle, such faces are triangulated and existing 

triangles are left unchanged. Only if all faces are already triangulated before the command begins are they 

meshed into smaller triangles. 

 The depth can now be reset in the Boolean Pocket command by pressing ENTER. 

 The Triangulate function has been rewritten to be faster and more reliable. 

There are differences in the triangulation it now produces, as the triangles are rearranged to avoid fan-like 

wedges of long, thin triangles. This makes the surface look more natural. 

No additional vertices are added, only new edges between existing vertices. This means that when 

handling badly shaped loops (such as those which cross themselves), the result can be very different from 

previous versions of MicroGDS. 

 The Remove Holes command has been rewritten to be faster and more reliable, especially for non-planar 

faces with holes. 

The split-lines which are added to join holes to the perimeter of the face (or to other holes) no longer split 

edges to join, but join to an existing vertex of the face. (This means, among other things, that the adjacent 

faces do not change from being triangles or quad faces when holes are removed.) In addition, if a face is 

badly twisted, or holes pulled outside the face, the modeller may triangulate the face to achieve a better 

result. 
 

These functions are used in many places: 

  the Mesh Clump, Mesh Surface and Mesh Face commands 

 the Quad Faces command, for all faces which are not triangles or quadrilaterals 

 the Remove Holes command (and triangulate if the face with holes is badly twisted) 

 in shaded views, to prepare triangles for DirectX shading 

 in hidden line views, if a face is non-planar 

 in the LightWorks Renderer, if a face is not planar 

 in the Solid Boolean commands, if a face is not planar 

Change case commands 
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The View menu 
The following additions and amendments have been made to the commands on the View menu. 

Setting the view to the XY plane 

In earlier versions of MicroGDS, the Axes XY Plane command set the view to the XY plane and also zoomed 

to display all graphics. In MicroGDS version 11 the current extent is maintained and the view is no longer 

zoomed. The following parameters are now set: 

 orthographic parallel projection, looking down the set axes Z 

 adjust the roll angle, swinging the set axes Y up 
 

Zooming to a new view extent 

To simplify the process of zooming 3D perspective views, two new modes have been added to the Zoom, 

Rectangle command: 

 mode one: move the look-at point to midway between the two snaps, and trim the perspective angle to fit 

the snaps 

 mode two: move the look-at point to midway between the two snaps, then advance so that the viewplane 

includes the viewplane projection of the two snaps 
 

The command starts with the default behaviour. You can then cycle through the three modes using TAB. Note 

that MicroGDS remembers the mode within the current work session. 
 

Saving and restoring window axes 

New Save Window Axes and Restore Window Axes commands have been added. For more details, see 

page 3. 

 

The Window menu 
The following additions and enhancements have been made to the commands on the Window menu. 

 

Managing profiles 

A new Profile entry has been added to the Window menu. This provides the following commands that you can 

use to manage your profiles: 

 Select to recall a previously saved profile 

 Save As to save the current layout to a new profile 

 Delete to delete an existing profile 

 Customize to customize toolbars, status bars, view controls, and shortcuts 
 

For more details about profiles, see page 6. 
 

Toolbar settings 

Toolbar settings are now saved in an xml file (Informatix\MicroGDS\11.0\settings.xml) under your Windows 

users‘ application data instead of in the Windows registry. 
 

View parameters 

A new ‗Mirrored‘ check box has been added to the View Parameters dialog box. This allows views to be 

mirrored in the X direction. Note that this does not affect text; text is drawn in a ‗normal‘ sense (as opposed to 

mirrored) in text primitives and mirrored photos. 
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General problems solved and minor enhancements 

 MicroGDS is no longer compiled to be compatible with Windows 2000. 

 Commands to open recently-used documents now show the full path of the file on the information bar (at 

the bottom of the MicroGDS window). 

 The 255 character limit on the word list of an enumeration mnemonic has been removed. 

Note that Cad.GetMnemDefLV will not read word lists longer than 255 characters. However, this function 

has been superseded by Cad.GetXMLAttrstyle which can read such lists. 

 Changes to a photo boundary which are then undone by the Photo, Show All command are now saved 

(when the document is saved). 

 You can now construct window photos in XML files. 

 Styles required for instances are now imported once again. 

 The limit of 800 characters has been removed from all attributes. 

 You can now move, as well as copy, phases from one window definition to another in the same document 

using drag and drop between the two windows‘ Window Editor (or Mini Window Editor). 

 A number of improvements and fixes have been made for constructing text: 

— pressing Enter to restart the Construct Text command now works correctly 

— text can now be pasted from Microsoft Word into the Construct Text and Edit Text dialog boxes 

In addition, improvements have been made when pasting text into a drawing using Paste Special as 

HTML. 

— extents of symbols, for example glyphs in CVF fonts, are now handled better so they are not clipped 

— the Input Method Editor (IME) composition window is positioned correctly in the Construct Text and 

Edit Text editors 

In MicroGDS 9 and 10, if the caret (insertion point) was at the far left of the control, the IME 

composition window would appear at the top left of your screen, rather than over the editor‘s window. 

This affected Japanese (Hiragana) input. 

— in the text editor, the End key now moves to the end of the line 

In earlier releases, for wrapped text, it would move to the beginning of the next line. 

 The Library Files tab of the Document Organizer can now show previews of MAN files. 

 The cursors for dragging styles in the Document Organizer have been modified. 

 An Origin snap now identifies the object origin when the mouse pointer is over a clump face. 

 The Construct, Dimension, Chain, Datum, and Run commands now centre their initial graphics feedback 

over the cursor, instead of out to the right. This makes it easier to see where the dimension line is going to 

appear. 

 For many commands, the graphics feedback is now smoother than in earlier versions. 

 Drag and drop of a window file last saved by MicroGDS version 9 or earlier from the Document 

Organizer into a document window (to create photo primitive) now works. In MicroGDS version 10.x this 

failed due to the lack of any named saved views. 

 MicroGDS now issues more informative error messages if export to an image format fails.  

 The following improvements have been made to PDF export: 

— text is now drawn manually if too distorted or edge-on. Previously this could result in a document 

appearing blank in Adobe Reader. 

— export now respects phase fading with opaque solid fill and pattern brushes 

— export now handles transparent OLE photos 

— photos with shaded views now works correctly if the view is extended by changing the boundary. 

Previously, photos did not draw outside the photo‘s stored view. 

— a number of improvements have been made when exporting text using CV7 symbols 

— if a nested style for hatching is missing, a simple linestyle is now used instead 



What’s new in MicroGDS 11 22  

 
 
 
 

— MicroGDS no longer crashes if zero-height text is used in a perspective view. 

— clipping of window photos to PDF has been improved. 

Specifically, MicroGDS now clips lines and so on, to the clipped photo boundary rather than the photo 

boundary. This has no visible effect, but affects the file size if parts of a photo are not visible. 

  MicroGDS XML parsing no longer relies on the system ID (the URL in the DOCTYPE) being accessible, 

but now recognises the MicroGDS public ID and loads a suitable DTD directly. 

 Using the Select command in Explorer-like mode, if you have several things selected and right-click one 

of them, all stay selected and the context menu applies to the entire selection. In version 10, the selection 

was reduced to only the item that was right-clicked. 

 MicroGDS no longer crashes if you switch documents and back again during a Construct Trace command. 

 The state of ‗Display snap guides‘ or ‗No snap guides‘ is now saved and restored as part of the saved 

settings. 

 Dotted lines in hidden view are now drawn with 1mm dashes and 1mm spaces, scaled in the same way as 

Output space linestyles. 

 Opaque fill strokes in linestyles applied as masks to text primitives no longer draw edges of lines to GDI+ 

output. 

 A new PLink reference has been added to secondary annotation for text primitives. 

 MicroGDS now observes the following Windows system policy settings: 

— ‗Do not keep history of recently open documents‘ 

— ‗Remove Run from Start menu‘ 

— ‗Run only allowed Windows applications‘ 

  Section Clip graphics have been improved. Edges in a front clip Section Clip plane now show the section 

linestyle in all edges. 

 MicroGDS now correctly handles foreign characters in Renderer image file names, even when they lie 

outside the current Windows locale. This affects all shaders that use a file name. 

 MicroGDS now makes un-aliased pathnames relative to the project directory when a file is saved, instead 

of absolute pathnames as in MicroGDS 10.0. 

 The Renderer‘s shader-editing dialog boxes (Material, Light, Environment) have been made more 

intelligent about the context of file names. For example, the first folder selected for an Image Cube shader 

is now remembered when browsing for the other five file names. 

 Render progress has been improved for QTVR movies. This provides a greater visibility of the progress of 

rendering these large and complex files. 

 If you have a view with Section Clipping and a cut-face Material style, and the phases of the window also 

have a Matstyle override, then you now see the cut-faces in the section plane with the section material 

style, not the phase style. If the section view specifies a linestyle name, then clip faces now shows the 

section linestyle, and is not overridden by the phase style. 

 You can now snap to the intersections of clump faces with each other and with the view‘s section planes. 

Line, Middle, and Point (intersection) snaps identify points on the relevant clump faces. 

 

DXF,DWG and DWF translation 
 

A number of changes have been made to improve the translation to and from DXF and DWG data. 

General changes 

 MicroGDS now reads and writes AutoCAD 2010 DXF and DWG files. 

 MicroGDS also reads and writes mesh entities and section objects (‗live‘ sections only). 

 DWGDirect, which MicroGDS uses to read and write DWG files, is now release 3.2. 

 Import and export of OLE data has been added to DXF/DWG translation (for AutoCAD 14 and later 

formats). 

 DXF/DWG code no longer attempts to preserve MicroGDS object names when round-tripping by adding 

attributes. 
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Import 

 If a DXF/DWG file has empty layer names, MicroGDS now allocates names before opening the file. 

 DXF/DWG import now processes left/centre/right/justified justification settings for paragraphs in multi-

line text (for AutoCAD 2008 and later formats). 

 Increased the use of plot styles for setting colours of phases, including phase overrides. 

 You are now informed only once if acadpoints font is missing. Previously, you were informed once per 

imported file. 

 A new setting has been added to the AutoCAD Import dialog box to specify the location in which to look 

for XREFs. The default is .\ which means look for XREFs in the same folder as the referencing file. 

Export 

 For DXF export, the number of decimal places is now fixed at 16; previously, you could set it to any value 

up to 16. 

 DWF export of photos with shaded views now correctly draws photos whose view has been extended (by 

changing the boundary). Previously, photos did not draw outside the photo‘s stored view. 

 Symbol filled linestyles are now written to DWF. 

 In general, DWF export has been improved in many areas, although gradient and raster fills are currently 

not supported. 

 Exporting rotated shaded views to DWF has been improved. 

 Photo clipping for DWF export has been improved to cope with nested photos. 

 DWF export of unrotated and undistorted JPEG rasters now use JPEG format (JFIF) within the DWF file 

to reduce file size. 

 DWF export of RGB/RGBA rasters now using PNG format (except when using JPEG as above). 

 DWF export of unrotated and undistorted 1-bit rasters now use CCITT Group 4 (T.6) TIFF format. This 

usually reduces the file size. Tiling for perspective views has also been improved. 

 A problem with export of photos when the project had an origin and the scale was not set to one has been 

fixed. 

 The dialog that prompts for file names (for XREFs) now gives the document name for external photos. 

 The Export to AutoCAD dialog box has a new option to omit screen-only phases from the resulting 

DXF/DWF file. 
 

 

Customization and application development 
This section outlines the additions and amendments to the Application Programming Interface (API) to 

MicroGDS since MicroGDS 10.0. 
 

If you need to install MicroGDS 11 and MicroGDS 8.x side-by-side on a computer, and arrange for an API 

custom application to run against either, refer to the Installing MicroGDS 11 guide supplied on the 

MicroGDS DVD. 
 

New functions are suffixed with (11). Modified functions are suffixed by the version of MicroGDS in 

which they were introduced. 

 

Visual 6 and the API 
Since the introduction of the MGDSNET class library for .NET programming in MicroGDS in 2004 and 

Microsoft‘s decision to no longer support or enhance the Visual Basic 6 development language, Informatix 

have now withdrawn support for the VB6 interface to the API. 
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To help application developers migrate to programming with .NET, please refer to: 

 ‗Hello.sln‘ is a Visual Basic .NET solution that contains a short worked example of using .NET with 

MicroGDS. 

This solution is in MicroGDS 11\Sample Applications\Hello in your MicroGDS installation. 

 

Axes 
In MicroGDS 11, each window definition in a document now has its own set of axes. When a window 

definition is opened, its axes are loaded from the window‘s stored values. When the axes‘ scale is moved or 

rotated, the axes can be explicitly saved so that it can be restored again later. The axes origin, rotation and 

scale, the units and decimal places, and the X and Y grid spacing are also stored. 
 

To support stored axes, the following new functions have been provided: 
 

Cad.AxesResynch (11) 

Public Shared Sub Cad.AxesResynch() 

This function resynchronizes the current conversation‘s link between the current document and set axes, 

linking set axes to the current set window. 
 

Cad.SetWndRestoreAxes (11) 

Public Shared Sub Cad.SetWndRestoreAxes() 

This function restores the working axes of the set window to its stored axes. 
 

Cad.SetWndSaveAxes (11) 

Public Shared Sub Cad.SetWndSaveAxes() 

This function saves the working axes of the set window to its stored axes. 
 

 
Notes: 

 The set axes are stored per window, and each window has a ‗working‘ copy of set axes. 

 Cad.SetWndRestoreAxes and Cad.SetWndSaveAxes copy the winow‘s working axes from and to the 

window‘s stored axes. 

 Where the user interface commands choose a window to work with when the command begins, the API 

automatically chooses a window for each conversation. The window is chosen the first time the axes are 

used in that conversation. The choice is fixed (apart from explicit API calls) throughout the conversation, 

so the program may assume consistent axes for making calculations. 

 The family of Cad.SetAxes and Cad.GetSetAxes functions set and get the values in the working axes of 

the chosen window. 

 If an API program just gets positions and creates graphics in one window, no change is needed; the 

program will automatically adopt the axes of the window used. The CadLink API will not automatically 

switch axes between windows in a single conversation. 

 If an API program opens and closes a series of windows, and works in turn in each, then it may be 

necessary to synchronize the API with windows as the program changes window (much as when switching 

documents the API should use Cad.DocResynch). The function for this is Cad.AxesResynch. 

If the program does not use Cad.AxesResynch when switching windows, the axes current at the start of the 

conversation will be used throughout the conversation. 
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Printing 
 

Cad.Print (11) 

Public Shared Sub Cad.Print( 

ByValue formatOptions As String, _ 

)As String 

This function prints the current window. 
 

Warnings 
 

Cad.GetWarnings (11) 

Public Shared Sub Cad.GetWarnings() As String 

This function returns warnings as an xml results string. 

Wide characters 

.NET versions of Cadlink and Cadfiler functions are now completely wide character. This will avoid data loss 

in strings not in the current locale. For example, you can now create a layer named in Japanese when working 

in English. 
 

For C++, wide character versions are now available for all API functions which previously took narrow 

strings and these have a W at the end of their names, or WF if they return the string values (for example, 

CadSetWndLabelW, CadPrefWF). 
 

The new C++ wide–character functions all have systematic (W)(F) names. Duplicates of the remaining V9 

and V10 functions which already accepted wide character arguments have now been added. The V9 and V10 

versions misused the ‗F‘ suffix as wide when it should have been reserved for ‗returns string + length‘. The 

new functions keep ‗W‘ solely for Wide and ‗F‘ solely for ‗returns string + length‘: 

 CadCreateFormattedTextF duplicated as CadCreateFormattedTextW 

 CadCurPriFormattedTextF duplicated as CadCurPriFormattedTextW 

 CadExportF duplicated as CadExportWF 

 CadGetCurPriFormattedTextF duplicated as CadGetCurPriFormattedTextWF 

 CadImportF duplicated as CadImportWF 

 CadOpenF duplicated as CadOpenWF 

 

Retired functions 

The following functions have been retired and are now deemed obsolete. Please migrate to using the 

appropriate replacement function, which is documented in the text of the retired topic. 
 

This list in shown in alphabetical order: 

 Cad.GetEntityMapName 

 Cad.GetPrefBIFFormat 

 Cad.GetPrefBIFRetainItems 

 Cad.GetPrefDXFBinary 

 Cad.GetPrefDXFExplode 

 Cad.GetPrefDXFLineTypeFile 

 Cad.GetPrefDXFPlaces 

 Cad.GetPrefDXFTextStyleFile 

 Cad.GetPrefDXFVersion 

 Cad.GetPrefPLOHatchSpacing 

 Cad.GetPrefPLOPens 

 Cad.GetPrefPLOSize 

 Cad.GetStyleMapName 

 Cad.IsEntityTableLoaded 



What’s new in MicroGDS 11 26  

 
 
 
 

  Cad.IsStyleTableLoaded 

 Cad.LoadEntityTable 

 Cad.LoadStyleTable 

 Cad.PrefBIFFormat 

 Cad.PrefBIFRetainItems 

 Cad.PrefDXFBinary 

 Cad.PrefDXFExplode 

 Cad.PrefDXFLineTypeFile 

 Cad.PrefDXFPlaces 

 Cad.PrefDXFTextStyleFile 

 Cad.PrefDXFVersion 

 Cad.PrefPLOHatchSpacing 

 Cad.PrefPLOPens 

 Cad.PrefPLOSize 

 Cad.SaveAsWRL 

 Cad.UnloadEntityTable 

 Cad.UnloadStyleTable 

Miscellaneous 
A new function, Cad.CurPriPolyline, has been added to replace the segments of a line or photo primitive by 

the segments of the supplied polyline. .Net provides two overloaded functions, defining either a polyline of 

straight-line segments with no bulges, or a polyline of lines, bulges, and bulge-axis vectors: 
 

Cad.CurPriPolyline (11) 

Public Shared Sub Cad.CurPriPolyline( 

ByValue nPoints As Integer, _ 

pointArray As Cad.Vector(), _ 

bulgeArray As Double(), _ 

axisArray As Cad.Vector() 

This function defines a polyline with mixed, straight or curved segments. 

Public Shared Sub Cad.CurPriPolyline( 

ByValue nPoints As Integer, _ 

pointArray As Cad.Vector) 

This function defines a polyline with just straight segments. 
 

Cad.TBarInsertButtonFromFile no longer prevents the resulting button from being copied into a flyout 

toolbar. 
 

Cad.GetSnapHit and Cad.GetNumSnapHits now retrieve the number of hits for the last snap resolved in 

the following functions: 

 Cad.GetArg 

 Cad.GetArgDrag 

 Cad.RubberBandLine 

 Cad.RubberBandArc 

 Cad.RubberBandCircle 

 Cad.RubberBandRectangle 
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Translation enhancements 

 Cad.Export can now publish to DWG, by giving DWG.Options as the XML. 

 Cad.Export can now take EMF.Options for EMF export. 

 Cad.Export can no longer set the number of decimal places for DXF; this is now fixed at 16. 

 Cad.Export has a new ExportScreenOnlyPhases property to specify whether to omit screen-only phases on 

export to DXF and DWG. 

 Cad.Export to XML format and helper classes (specifically 

Informatix.MGDS.Export.PageImageBase.Options) now treat perspective views separately to others. 

Therefore, there is now a new PerspectivePaperSize property of type TwoDThreeDPaperSize. 

 Helper class member Informatix.MGDS.Export.DXF.Options.DecimalPlaces for use with Cad.Export 

 DXF/DWG translation now defaults to 16 rather than null, so default settings are usable. 

 A new UsePhotoPhaseOverrides property has been added to Informatix.MGDS.Import.DXFDWG (used 

for Cad.Open/Cad.Import). This  specifies whether or not to use photo phase overrides for import of 

XREFs. 

 The default value for the XrefFallbackSearchPath property for 

 Informatix.MGDS.Import.DXFDWG.Options is now ‗./‘ instead of null. 

 The following changes have been made to Cad.ExportView: 

— PLO and WRL formats have been withdrawn. 

— AUTOCADLAYER keyword for DWG and DXF export is no longer accepted. 

 A new option for FromView for ColourMapping for export using Cad.Export to BMP, TIFF, and PNG 

files to use either Colour or BlackAndWhite as defined by the view. 

 The PLO and WRL formats have been withdrawn from Cad.SaveAs. 

API problems solved and minor enhancements 

 The PEN phase option in Cad.CurPhase has been withdrawn. 

 Cadfiler and Cadlink functions that return strings may now truncate their returned data to fit in the space 

provided by the API program. This ensures that there is no partial Unicode characters left. 

 The plink parameter of the following functions can now also identify a photo, raster, or OLE primitive: 

— Cad.GetObjectCountPrimPoly 

— Cad.GetObjectLinksPrimPoly 

— Cad.ObjectScanPrimPoly 

— Cad.PrimScanPrimPoly 

— Cad.SelectPrimPoly 

— Cad.PointInPrimPoly 

The current primitive for Cad.ObjectScanLayer can also identify a photo, raster or OLE primitive.  

 All scan functions that accept a string to indicate hittable/editable now accept ―E― for editable and either 

―H― or ―― for hittable. 

 A new option for SingleUserFile.Options for Cad.Import and Cad.Open, WhenMnemonicClash, gets or 

sets the action to take if a file being imported defines an attribute that clashes with the mnemonic in the 

document that it‘s being imported into. 

 There are several new errors for functions that produce BMP, TIFF, PNG, or JPEG files. 

 The following functions now require, and return, quotation marks around any editor executable file name 

which contains spaces: 

— Cad.PrefBmpDibEditor and Cad.GetPrefBmpDibEditor 

— Cad.PrefEpixEditor and Cad.GetPrefEpixEditor 

— Cad.PrefJpegEditor and Cad.GetPrefJpegEditor 

— Cad.PrefTiffEditor and Cad.GetPrefTiffEditor 
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 The CommandStart and CommandEnd events for transparent commands are generated more consistently 

than in previous versions of MicroGDS. 

 MicroGDS no longer shows snapcodes when the padlock mouse pointer is showing during a conversation. 

 The previous limit of 100 for the number of copies for Cad.ArrayPathSel has been removed. 

 The RightButton.Hook enumeration has been removed. This was a copying error for Origin and did not 

work. 

 Cad.PrefRasterCache now takes effect immediately. Previously, it took effect the next time the 

Preferences dialog box‘s OK button was clicked and in the next MicroGDS session (after saving settings). 

 A number of functions which previously reported ―The current primitive is not a line‖ 

(MAE_CURPRINOTLINE), but which could act on a line or photo primitive, now report ―The current 

primitive is not a line, photo, raster or OLE primitive‖ (MAE_CURPRINOTLINEORPHOTO). 

 Cad.CurPhase and Cad.GetCurPhase have new ‗respectprimitivecolours‘ options. 

 In c# helper classes and so on, in Informatix.MGDS.Export.DXFDWG for the .NET interface to Cadlink: 

LineTypesFile renamed LinetypesFile, LineTypes renamed Linetypes, CharTypesFile renamed 

ChartypesFile, CharTypes renamed Chartypes. 

 A problem introduced in MicroGDS version 9.0 where Cad.DocViewNext would report scan-ended, but 

not properly clears the scan so a subsequent call would report end of scan rather than an error has been 

fixed. 

 As part of the new per-window axes settings and the configuration project, Cad.SetAxesXXX and 

Cad.GetSetAxesXXX, and Cad.SetUnits and Cad.GetSetUnits no longer accept attempts to work when no 

document is open. They do however work when there is no open window. 


